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appendix

C

Office 2001, Menu by Menu

Because Microsoft Office 2001 is four big programs that work together, there
are a lot of menus to cover—one set for each different program. While some
of these menus overlap, there are some significant differences. These menus

also change depending on what’s selected in your currently open document.

This special online appendix to Office 2001 for Macintosh: The Missing Manual takes
the menus program by program, so you can look up what you need easily. It’s de-
signed as a bonus appendix for owners of the actual book; the page-number cross-
references here, for example, are keyed to the pages of the book itself.

Entourage Menus
Entourage’s menus, not surprisingly, center on manipulating mail and newsgroup
messages, with a whole set of submenus for dealing with tasks, appointments, and
contacts thrown in for good measure.

File Menu
Like any other good Macintosh program, Entourage comes equipped with the File
menu, which is mainly used for working with files on your hard drive—whether
that’s creating new files, saving them, or printing them.

Project Gallery
It’s the top File menu item in all four Office applications, and it opens the Office
Project Gallery window when selected. Keyboard shortcut: c-Shift-P.

New
Creates a new Entourage file. Since Entourage can create a variety of files, the New
command has its own submenu, filled with commands that creates a new Entou-
rage document or element.
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• New. This top item changes, depending on what’s selected in Entourage’s Folder
List window. It might say, for example, New Mail Message, New Newsgroup mes-
sage, New Task, and so on. Keyboard shortcut: c-N.

• Mail Message. Creates a blank email message. Keyboard shortcut: c-Option-N.

• News Message. Creates a blank newsgroup message.

• Calendar Event. Creates a blank calendar event.

• Task. Creates a blank task.

• Note. Creates a blank note.

• Contact. Creates a blank contact.

• Group. Creates a blank group, in which you can gather together contacts.

• Folder. Creates a new folder in the Folder List. Keyboard shortcut: c-Shift-N.

• Subfolder. Creates a new subfolder in the folder that’s selected in the Folder List.

Open
Opens the selected item into its own window, whether it’s an item in the Folder List
(such as a mail folder or the Address Book) or an item inside the browser window
(such as a news message or a contact). Keyboard shortcut: c-O.

Close
Closes the frontmost open window, even if it’s the Progress window. You can’t close
Entourage’s main window with this command. Keyboard shortcut: c-W.

Save
Saves any changes made to the frontmost window, whether that window is an email
message (which then gets placed in the Drafts folder) or a contact. If the document
in the frontmost window hasn’t been changed, then the Save command is disabled.
Keyboard shortcut: c-S.

Save As
Saves the frontmost window as another file. This command essentially makes a copy
of the file and closes the original, allowing you to choose a new name and location
for the file.

Save As Custom View
After you’ve performed a search, you can use this menu command to save the search
as a custom view, which can save you time later; you can use the search criteria as the
definition for the view (see page 386).

Save As Web Page
Lets you save your calendar as a Web page, so that others on the Internet can see
what you’re up to—if you really want that kind of scrutiny (page 351).

Entourage Menus
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Revert
Throws out any changes that you’ve made to the file in the frontmost window since
you last saved it.

Import
Opens Entourage’s Import window, which lets you bring in information from vari-
ous email, personal information manager, and text-based mail and contact files (page
287).

Export Contacts
Saves Entourage’s contacts as a text file, which you can then use in another program.

Page Setup
Opens the Page Setup dialog box, in which you can control how Microsoft Office
prints your pages (on which kind of paper, etc.). The options here depend on the
kind of printer you have selected in the Chooser.

Print One Copy
Prints a copy of the frontmost window (or the item selected in the main window)
without opening the Print dialog box. Think of it as the fast track to printing. Key-
board shortcut: c-Option-P.

Print
Opens the Print dialog box, in which you can specify how many copies you want
printed, among other things. Keyboard shortcut: c-P.

Work Offline
Disconnects Entourage from the Internet without closing Entourage, so that you
can you write email messages, reply to news messages, or work with tasks, calendar
items, or contacts. Useful when, for example, you’re on a plane, and would rather
squelch Entourage’s automatic mail-getting schedule (which would otherwise re-
mind you every 10 minutes, “Error trying to get online”).

Switch Identity
Switches your Entourage identity, which lets you (or another person using Office)
use a different set of accounts (see page 382). Keyboard shortcut: c-Shift-Q.

Quit
Quits Entourage, but before doing so, offers you a chance to save any changes you’ve
made. Keyboard shortcut: c-Q.

Edit Menu
The Edit Menu commands focus on editing tools, whether that means moving text
around in an email message, looking for a text string inside Entourage’s files, chang-
ing message categories, or editing the program’s preferences.

Entourage Menus
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Undo
Takes back the last thing that you did, such as deleting that vital chunk of text by
accident. Once you’ve undone something, the Undo menu turns into the Redo menu,
in case you’ve changed your mind. Keyboard shortcut: c-Z.

Cut
Cuts the selected text or object out of the document and puts it on the Clipboard,
ready for pasting into a different window or program. Keyboard shortcut: c-X.

Copy
Copies the selected text or object and puts it on the Clipboard, ready for pasting
into a different window or program. Keyboard shortcut: c-C.

Paste
Pastes the contents of the Clipboard into a document at the location of the insertion
point. Keyboard shortcut: c-V.

Paste As Quotation
Pastes the text on the Clipboard into an open Entourage window as an Internet-
style quotation—that is, with > brackets in front of each line, to let your correspon-
dent know you’re quoting back something she wrote. Keyboard shortcut: c-’.

Clear
Clears the selected text (or object) from the document without putting it on the
clipboard.

Select None
Unselects any object that’s selected in the frontmost window. Keyboard shortcut: c-
Shift-A.

Select All
Selects everything (whether that’s text or objects) in the frontmost window. Key-
board shortcut: c-A.

Duplicate
Duplicates the currently selected item, whether it’s a message or a calendar event.
This command’s wording changes to reflect the kind of object that’s selected; it may
say Duplicate Message or Duplicate Task, for example. (It can’t duplicate items on a
remote server, such as an online email account or a news server.) Keyboard shortcut:
c-D.

Delete
Deletes the selected item (such as a mail message, contact, or folder in the Folder
list). Like Duplicate, the Delete command’s wording changes to reflect the item be-
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ing deleted, and it can’t be used to delete messages on a news server. Keyboard short-
cut: c-Delete.

Delete Thread
Sort of the überversion of Delete—it deletes an entire message thread. Keyboard
shortcut: c-Option-Delete.

Categories
This menu lists Entourage’s categories (a way of labeling your Entourage data, as
described on page 390), and it gives you two commands to use with those catego-
ries: Assign Categories lets you place the selected item (such as a message or a folder)
into one or more of your categories; Edit Categories lets you create, change, and
delete Entourage’s categories. The prefab categories included in Entourage are: None,
Family, Friends, Holiday, Junk, Personal, Recreation, Travel, and Work.

Auto Text Cleanup
Auto Text Cleanup contains six tools to help turn email text into cleaner text, re-
moving some of its gremlins.

• Straighten Quotation Marks. Takes fancy curly quotes and turns them into stan-
dard straight quotes.

• Rewrap Paragraphs. Pulls out the line breaks in the text of a message (see page
307).

• Increase Quoting. Increases the level of Internet quoting (with all of the > signs
on the left margin of the text) by one.

• Remove Quoting. Decreases the level of Internet quoting by one.

• To UPPERCASE. Makes the selected text all capitals.

• To lowercase. Makes the selected text all lowercase.

Decrease Font Size
Makes the text of an incoming message smaller. Keyboard shortcut: c-Shift-hyphen.

Increase Font Size
Makes the text of an incoming message larger. Keyboard shortcut: c-Shift-=.

Find
Opens Entourage’s Find panel, which you can use to search through messages for a
text phrase (see page 384). Keyboard shortcut: c-F.

Advanced Find
Opens Entourage’s Advanced Find window, which lets you search using all kinds of
criteria to narrow your search (see page 384). Keyboard shortcut: c-Option-F.

Entourage Menus



644 office 2001: the missing manual

Find Related Items
Lets you search for messages sent to or received from the currently selected contact.

Preferences
This menu has two submenus—General and Mail & News; each opens one of the
panes in Entourage’s Preferences window.

• General. Opens Entourage’s General Preferences window, which is divided into
six categories that covers how Entourage works, particularly the Address Book
(Chapter 10) and Calendar (Chapter 9). Keyboard shortcut: c-;.

• Mail & News. Opens Entourage’s Mail & News Preferences window, which is di-
vided into five categories that cover how Entourage deals with mail and news
messages (see Chapter 8). Keyboard shortcut: c-Shift-;.

View Menu
The View Menu’s commands control how Entourage looks and shows you things.

Previous
Moves to the previous item in the currently selected folder. If a message is open, the
contents of the open window changes to the previous message. Keyboard shortcut:
c-[.

Next
Moves to the next item in the currently selected folder. If a message is open, the
contents of the open window changes to the next message. Keyboard shortcut: c-].

Toolbars
Hides or shows the toolbar in Entourage’s main window (a space-saving gesture).

Folder List
Hides or shows the Folder List in Entourage’s main window.

Preview Pane
Hides or shows the Preview Pane in Entourage’s main window. Keyboard shortcut:
c-\.

Columns
The Columns menu lets you hide or show the various columns in Entourage’s main
list view. The columns that you can toggle are: Links, Online Status, Message Status,
Priority, Attachment, From, Subject, Sent, Received, To, Account, Size, and Catego-
ries. To save space, hide the ones you rarely consult.

Internet Headers
Reveals the Internet headers that show where the message has been on its travels
through cyberspace. It works only on messages that are open in their own windows,
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not on messages in the Preview pane.

Source
Opens the selected message’s HTML source code—including its headers—so you
can take a look at the formatting codes that make it up.

Unread Only
Hides all messages but the ones you haven’t yet read. (Choose the command again
to bring them back into view.) Keyboard shortcut: c-Y.

Flagged Only
Makes flagged messages the only thing that you see in list windows. Keyboard short-
cut: c-Shift-Y.

Threaded
Pulls a message and its replies together under one heading in the message list—
turns it, in other words, into a thread, so that it’s easier for you to follow the discus-
sion that’s gone on over several days. Choose this command again to restore the
original pell-mell order of messages in the list.

Expand All
Opens up all threaded messages so that you can see every one.

Collapse All
Closes all threaded messages so that only one message (and its flippy triangle) can
be seen.

Message Menu
The Message Menu provides all manner of commands for dealing with messages, as
you may have guessed.

Resend
Resends a selected message in the Sent Items folder. (If a message in the Out box is
selected, this command says Send Message Now instead, and its keyboard shortcut
is c-K.)

Receive Entire Message
If you’ve selected a partially retrieved message, this command tells Entourage to
receive the rest of the story. (If you have selected a message in the Out box, this
menu item changes to say Send Message Later, and its keyboard shortcut is c-Shift-
K.)

Edit Message
Makes a previewed message editable, so that you can change its text—even if you
didn’t create the message.
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Reply
Creates an outgoing reply message for the selected message, with subject, address,
and date already filled in. If the message comes from a mailing list, the reply will be
addressed to the entire mailing list. Keyboard shortcut: c-R.

Reply to All
Creates a reply to the selected message, pre-addressed to every recipient of the origi-
nal message. Keyboard shortcut: c-Shift-R.

Reply to Sender
Creates a reply to the selected message, pre-addressed to the sender only. Keyboard
shortcut: c-Option-R.

Forward
Forwards the message to a third party, first permitting you to add your own com-
ments to it before you send it along to someone else. Keyboard shortcut: c-J.

Redirect
Redirects the selected message to someone else, which makes it appear as though it
came from the original sender (see page 308). Keyboard shortcut: c-Option-J.

Mark as Read
Marks the currently selected message so that it looks like you’ve already read it (it
stops being bold). Keyboard shortcut: c-T.

Mark as Unread
Marks the currently selected message as unread (it turns bold)—useful if you’ve
already read it but want to pretend as if you haven’t. Keyboard shortcut: c-Shift-T.

Mark All as Read
Marks all messages in a folder as having been read. Keyboard shortcut: c-Option-Y.

Flag
Marks the currently selected message (or messages) with a flag in the list view. The
flag also shows up next to the folder in the Folder List where the message is currently
filed (see page 310).

Flag for Follow-up
Opens the follow-up window (a specialized kind of task window) in which you can
set a time to be reminded to take action concerning the flagged message (see page
310). It also puts a flag next to the item in the list view, and next to the item’s folder
in the Folder List.

Clear Flag
Removes the flag from a flagged message.

Entourage Menus



appendix c: office 2001, menu by menu 647

Insert Hyperlink
The three submenu commands here let you insert, into an outgoing email or news-
group message, a Web link from the currently open Internet Explorer windows, from
Internet Explorer’s Favorites file, or from Internet Explorer’s History file, respec-
tively.

Signature
Lets you select the signature for your outgoing message (see page 325).

Priority
Lets you set a priority for your outgoing Entourage message (which will be flagged
accordingly in your recipient’s email program, if it understands such priority set-
tings).

After Sending, Move To
Lets you set a destination folder for your outgoing message. Once you’ve sent it,
Entourage will move the message to the selected folder.

Move To
This menu command moves the selected message or messages to a folder in the
list—a great feature when you’re slogging through a mass of messages, trying to
clean them up. Its submenu offers a list of folders and a special Move To Folder
command.

• Folder list. This is a list of Entourage folders to which you can move the selected
message.

• Move To Folder. Opens a list of all of Entourage’s folders; you can move the
selected message to any of them. You can also create a new folder using the con-
trols in this window. Keyboard shortcut: c-Shift-M.

Priority
This menu sets the priority of the selected message from one of five possible choices:
Highest, High, Normal, Low, and Lowest.

Apply Rule
Applies mail rules (see page 315) to the selected message or messages, even though
they’ve already been downloaded to your machine. The submenu shows two things:
your list of individual rules and All Rules, which applies all of your rules to the
selected messages.

Add Attachments
Lets you add an attachment to an open message that you’re creating (see page 326).

Entourage Menus



648 office 2001: the missing manual

Save All Attachments
Opens up a Save dialog box in which you can save any file attachments to the cur-
rently selected message onto your hard drive (see page 313). This command is dis-
abled if a message doesn’t have any attachments.

Remove All Attachments
Removes any attachments to the selected message. Great for stripping away annoy-
ing VCF files.

Format Menu
Even though email and news messages both trace their origins to plain text (which
doesn’t contain much in the way of formatting), the advent of HTML email lets you
use a variety of formatting in your missives—provided you heed the warnings on
page 323. Those commands are thoughtfully grouped in the Format menu.

HTML
If HTML is checked, then all of the Format menu commands listed below are avail-
able; otherwise, most of the commands below are dimmed, and you’ll prepare your
email messages using plain, unformatted text only.

Style
Lets you choose from five different styles for your text, detailed below:

• Regular Text. You guessed it—plain vanilla text.

• Bold. Makes the selected text bold. Keyboard shortcut: c-B.

• Italic. Makes the selected text italic. Keyboard shortcut: c-I.

• Underline. Underlines the selected text (and makes it look like a hyperlink—
great for practical jokes). Keyboard shortcut: c-U.

• Fixed Width Font. Uses a fixed-width font, such as Monaco. A fixed-width font is
one in which each character takes up the same amount of horizontal space: e.g.
an “i” takes up as much space as an “m,” making it easier for you to line up text in
columns.

Font
Lists all of the fonts installed on your Mac. Choose one to use in your message.

Font Size
Lets you choose from one of five sizes for your fonts: Largest, Larger, Medium, Smaller,
and Smallest. (In HTML, you can’t choose a specific point size for your fonts.)

Font Color
Lets you choose a color for your HTML-based email fonts. It lists 16 colors: Black,
Maroon, Green, Olive, Navy, Purple, Teal, Gray, Silver, Red, Lime, Yellow, Blue, Fuchsia,
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Aqua, and White—plus Other, which lets you use the color picker to mix your own
color.

Background Color
Lets you choose a shade for the background of your HTML email messages.

Character Set
Lets you choose a language character set for your outgoing mail: Western European,
Central European, Chinese, Cyrillic, Greek, Japanese, Korean, Turkish, and Unicode.
It also has an Automatic selection to automate the process.

Heading
Lets you choose a preformatted, HTML heading level for a paragraph of text in your
message: from Heading 1 to Heading 6, in decreasing order of bigness and boldness.
You can remove the Heading level altogether by choosing None.

Alignment
Chooses alignment for the selected paragraphs: Left, Center, or Right.

Numbered List
Turns the selected text into an HTML numbered list.

Bulleted List
Turns the selected text into an HTML bulleted list.

Increase Indent
Indents the selected paragraphs (when creating a quotation, for example).

Decrease Indent
Decreases the indent level.

Insert Horizontal Line
Inserts a horizontal rule into an HTML formatted outgoing message.

Tools Menu
Where would a Microsoft program be without a Tools menu? Here you’ll find com-
mands that deal with Entourage’s general utility operations.

Run Schedule
Here’s a look at each item in the submenu (see page 295 for more on schedules):

• Empty Deleted Items Folder. Empties the Deleted Items folder of its contents.

• Send & Receive All. Sends all queued messages and gets mail from all accounts.

• Send All. Sends all waiting messages.
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• Edit Schedules. Opens the Schedule window, where you can create, edit, and de-
lete schedules.

Send & Receive
This command’s submenu lets you send your waiting outgoing mail and download
any email waiting for you.

• Send & Receive All. Sends all waiting messages and gets mail from all accounts.
Keyboard shortcut: c-M.

• Send All. Sends all waiting messages (but doesn’t download incoming mail). Key-
board shortcut: c-Shift-K.

• List of accounts. Every account you have in Entourage is listed here; by selecting
the account name, you make Entourage send and receive messages for that one
account.

Spelling
Checks the spelling in your message (see page 392). Keyboard shortcut: c-Option-L.

Change Dictionary
Use the Change Dictionary submenu to choose your dictionary language from the
following choices: Danish, Dutch, English (Australian), English (UK), English (US)
French, French Canadian, German, Italian, Norwegian Bokmal, Norwegian Nynorsk,
Spanish, and Swedish.

AutoCorrect
Opens Entourage’s AutoCorrect settings window, in which you can set how Entou-
rage automatically attempts to fix your mistakes and add formatting to your mes-
sages, exactly as in Microsoft Word (see page 84).

Dictionary
Opens the Office definitions dictionary and looks up the selected word in it.

Check Names
Searches directory services (see page 322) for the name or email addresses that you’ve
entered in the To, CC, or BCC fields of a message. Keyboard shortcut: c-Shift-C.

Add to Address Book
Adds the email address of the recipient or sender of a message to your address book—
a brilliant and useful feature. Keyboard shortcut: c-=.

Open Links
Opens a list of links (see page 311) to the selected item or message.
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Link to Existing
Lets you link to an existing Message, Calendar Event, Task, Note, Contact, Group, or
File, using the Links dialog box (page 311).

Link to New
Lets you link to a Mail Message, News Message, Calendar Event, Task, Note, Con-
tact, or Group that you haven’t yet created, and offers you the chance to create it in
the process.

Junk Mail Filter
Opens the Junk Mail Filter window, in which you can set the filter’s options (page
318).

Mailing List Manager
Opens the Mailing List Manager, in which you can set options for dealing with mail-
ing lists (see page 317).

Rules
Opens the Rules window, in which you can create, edit, or delete message rules (see
page 315).

Newsgroup Settings
Lets you set character-set options for the selected newsgroup.

Directory Services
Opens the Directory Services window, where you can search for someone’s email
address or name from a directory service server (see page 322).

Signatures
Opens the Signatures window, in which you can create, edit, or delete signatures for
your messages (see page 325).

Schedules
Opens the Schedules window, in which you can create, edit, or delete schedules (see
page 295).

Accounts
Opens the Account window, in which you can create, edit, or delete mail, news, and
directory service accounts (see the beginning of Chapter 8).

Window Menu
The Window menu corrals all of the window-related Entourage commands in one
place.
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Main Window
Opens the Entourage main window. Keyboard shortcut: c-1.

Address Book
Opens the Address Book (Chapter 10). Keyboard shortcut: c-2.

Progress
Opens the Progress window, which shows how network operations are progressing.
Keyboard shortcut: c-3.

Calendar
Opens the Calendar window (Chapter 9). Keyboard shortcut: c-4.

Tasks
Opens the Tasks window (Chapter 9). Keyboard shortcut: c-5.

Notes
Opens the Notes window (Chapter 10). Keyboard shortcut: c-6.

Link Maker
Opens the Link Maker window (see page 311). Keyboard shortcut: c-7.

Error Log
Open Entourage’s Error Log, which tells you about any problems the program had
in sending or receiving your messages. Keyboard shortcut: c-8.

Cycle through Windows
Moves from one open window to the next, one at a time. Keyboard shortcut: c-~.

Window List
All of the open windows are listed at the bottom of the Window menu. To switch to
an open window, select it from this list.

Scripts Menu
Entourage works well with AppleScript—so well that it reserves an entire menu for
scripts. You can use one of the included scripts, and you can add your own scripts to
this menu.

About This Menu
Opens a dialog box that tells you about the script menu.

Create Event from Message
Attaches the selected message’s text to a new Entourage Event (a nifty trick if the
message contains, for example, directions to a party). Keyboard shortcut: Control-E.
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Create Note from Message
Attaches the selected message’s text to a new Entourage Note. Keyboard shortcut:
Control-N.

Create Task from Message
Attaches the selected message’s text to a new Note. Keyboard shortcut: Control-T.

Insert Text File
Lets you select a text file from your hard drive that Entourage then inserts as the
body of an outgoing email message, note, or other text window.

Save Selection
Saves the selected text as a text file on your hard drive.

Help Menu
The Balloon Help commands in the Help menu are provided by the Mac OS itself,
but a few are Office-specific.

Turn Assistant Off
That’s right—you can turn off the Office Assistant (Max, the animated Mac Plus) by
selecting this menu command.

Microsoft Entourage Help
Opens up Entourage’s online help, as described in Appendix B.

Microsoft Entourage Tour
Opens your Web browser of choice and gives you a screen-by-screen overview of
Entourage—no tour guide, no tipping. It’s a pretty slick tour.

Contents and Index
Opens the Contents and Index portion of Entourage’s online help window (Appen-
dix B).

Help on the Web
Launches your Web browser, which displays a list of Web pages that have helpful
contents (again, details in Appendix B).

Online Registration
If you haven’t registered Office yet (sent your address to Microsoft so that it may
send you junk mail), select this menu item to start the ball rolling.

Excel Menus
These menus are the same no matter what kind of document is open.
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File Menu
The commands in the File menu open Excel workbooks, whether you’re opening
them, saving them, or printing them.

Project Gallery
It’s the top File menu item in all four Office applications, and it opens the Office
Project Gallery window. Keyboard shortcut: c-Shift-P.

New
Creates a new Excel workbook. Keyboard shortcut: c-N.

Open
Opens Excel’s Open dialog box, which you can use to navigate to a file for Excel to
open. Keyboard shortcut: c-O.

Close
Closes the frontmost Excel workbook window. If the workbook has unsaved changes,
Excel will ask you if you want to save those changes. Keyboard shortcut: c-W.

Save
Saves any changes to the frontmost window. If the file is a new, unsaved workbook,
Excel prompts you to name it and choose a location for it. Keyboard shortcut: c-S.

Save As
Saves the frontmost window as another file. This command essentially makes a copy
of the file and closes the original file, allowing you to choose a new name and loca-
tion for the file, if you want.

Save as Web Page
Saves the frontmost Excel workbook as a Web page, converting graphics and graphs
to the right kind of graphic formats, and saving all of the data in HTML tables (see
page 483).

Save Workspace
Memorizes the positions and sizes of any open workbook windows into a separate
file; later, when you open that file, all of the workbooks will be opened to the same
size and position.

Web Page Preview
Shows you, in your Web browser, what your workbook will look like as a Web page
(see page 483).

Page Setup
Opens the Page Setup dialog box, where you can set up your Excel printouts. The
options depend on the kind of printer you have selected in the Chooser.
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Print Area
Offers two commands:

• Set Print Area. Lets you drag to select the cells you want to print.

• Clear Print Area. Undoes the Set Print Area command, so that nothing is se-
lected for printing.

Print Preview
Opens up the Print Preview window, which shows how a workbook will look when
you print it (page 467).

Print
Prints the frontmost document on the printer selected in the Chooser. It opens the
Print dialog box, in which you can specify how many copies you want printed and
make other printing-related settings. Keyboard shortcut: c-P.

Send To
Excel’s Send To submenu has only one item: Mail Recipient. By selecting that op-
tion, Excel tells Entourage to send the frontmost file as a file attachment to an email
message. It’s a great feature, saving you several steps when you’re finished working
on a spreadsheet and want to email it straight to the interested parties.

Properties
Opens the Workbook Properties window, in which you can view and type in key-
words and other information about the frontmost workbook, for use later by the
Find File function (which appears when you choose File→Open).

Quit
Tells Excel to quit. Before it does, the program will ask you if you want to save changes
to any of the open files that have unsaved changes. Keyboard shortcut: c-Q.

Edit Menu
The Edit Menu gathers together all of Excel’s Edit tools into one handy place. Many
of these commands are similar to, but not identical to, those in other Office pro-
grams’ Edit menus.

Undo
As in other programs, this command restores the last change you made; in Excel,
you can undo (or redo) many steps, taking your spreadsheet all the way back to the
way you found it. Keyboard shortcut: c-Z.

Repeat/Redo
When you’ve done something that Excel can do over and over again, you can do so
just by selecting the Repeat command. If you’ve just used the Undo command, the
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Repeat menu item turns into Redo, which undoes the undo you just did. Keyboard
shortcut: c-Y.

Cut, Copy, Paste
Cuts, copies, and pastes the selected cell, cells, or object (see page 408). Keyboard
shortcut: c-X, -C, and -V, respectively.

Paste Special
Lets you exercise some control when pasting, by pulling up the Paste Special win-
dow, where you can apply formatting (see page 409). It also lets you link or embed
the clipboard contents.

Paste as Hyperlink
Pastes the clipboard contents into Excel as a hyperlink, either to a Web site or to a
Word document. (Requires that you’d first copied an Internet address or some text
out of a Word document.)

Fill
Fills the selected range of cells in the manner you specify in the Fill submenu. There
are several different kinds of fills:

• Down, Right, Up, Left. Fills the selected range of cells with the contents and for-
matting the first select cell, in the specified direction (see page 404 for a more
patient discussion).

• Across Worksheets. If you have multiple sheets selected, this copies the selected
range of cells across all of the selected worksheets in the same place as the origi-
nal selection.

• Series. Intelligently fills the selected range of cells using the contents of the first
cell in the selected row or column as a pattern—useful for filling in a series of
dates, for example (see page 405).

• Justify. Spreads the text in the leftmost cell across the selected row of cells.

Clear
The Clear menu empties out a cell or cells; although you might not know it, there
are several ways to clear cells. Here are your choices:

• All. Clears everything in the cell, including formatting, the cell’s contents, and
any comments.

• Formats. Clears just the cell’s formatting, leaving contents and comments alone.

• Contents. Clears just the cell’s contents, leaving formatting and comments alone.

• Comments. Clears any comments, leaving formatting and contents alone.
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Delete
Deletes the selected cells or object from the sheet. If you’re deleting cells, Excel will
ask you whether you want to shift cells up or to the left, or remove entire rows or
columns.

Delete Sheet
Deletes the currently active sheet from the workbook. Be sure about it; you can’t
undo this action.

Move or Copy Sheet
Moves the selected sheet or sheets to a different location in the same workbook or
another workbook. It opens the Move or Copy window, in which you can specify
where you want to move the sheet and whether or not a copy is made.

Find
Opens the Find panel that you can use to search for a string in formulas, values, or
comments (see page 411). Keyboard shortcut: c-F.

Replace
Looks for a string of text and replaces it with another (see page 411). Keyboard short-
cut: c-H.

Go To
Opens the Go To window, which you can use to go to a specific cell. By clicking the
resulting Special button, you can also use it to select a specific type of cells, such as
those containing formulas or constants.

Links
Pulls up a window that shows information about every link in the currently active
document. If the document doesn’t have any links to other documents, this option
is blank.

Object
Lets you edit an embedded object, such as a Microsoft Graph object or a Microsoft
Organization Chart object. This menu’s name changes to reflect the kind of object
that’s embedded here, and it lets you either edit an embedded object or convert one
OLE object to a different type.

Preferences
Opens Excel’s Preferences window.

View Menu
The View menu’s commands govern what view mode the windows are in, what tool-
bars are shown, and so on.
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Normal
This is the standard Excel spreadsheet view.

Page Break Preview
Switches to Page Break view mode, in which you see your worksheet as it will print
(see page 467). You have to have a printer connected to your Mac and properly
chosen in the Chooser for this to work properly.

Formatting Palette
Hides or shows the Formatting Palette (see page 437).

Toolbars
Using this command’s submenu, you can hide or show 15 of Excel’s toolbars: Stan-
dard, Formatting, Border Drawing, Chart, Drawing, External Data, Forms, List,
Movie, Picture, PivotTable, Reviewing, Visual Basic, Web, and WordArt. There is a
sixteenth option in this submenu called Customize, which opens the Customize
window, where you can select more toolbars or create your own (see Chapter 17).

Formula Bar
Hides or shows the Formula Bar. Again, this is one that you should probably leave
on, as you’ll be using the formula bar quite a bit.

Status Bar
Hides or shows the status bar at the bottom of an open workbook.

Office Clipboard
Opens the Office Clipboard floating window.

Header and Footer
Lets you edit the headers and footers that appear at the top and bottom of every
page.

Comments
Shows all comments in the document if they’re hidden, and opens the Reviewing
toolbar. If comments are already visible, choosing this hides them.

Custom Views
Opens the Custom Views window, which you can use to add, delete, or show custom
views that you’ve saved.

Report Manager
Opens the Report Manager window, in which you can add, edit, delete, and print
custom reports. A report is a combination of views, scenarios, and sheets that you
can print (see page 513).
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Full Screen
Turns Full Screen mode on and off. In Full Screen mode, your workbook enlarges to
take over the entire screen, and Excel hides other elements (such as toolbars, the
Formatting Palette, and the Office Assistant).

Zoom
Opens the Zoom window, in which you can choose one of seven zoom levels (25, 50,
75, 100, 125, 150, or 200 percent) for magnifying or shrinking the onscreen repre-
sentation of your spreadsheet, or you can zoom in or out to fit a selection. You can
also enter a custom zoom level (from 10 to 400 percent).

Sized to Window
If you have a chart embedded in its own Chart Sheet, this command ties the size of
the chart to the size of the window in which it’s embedded. If this command isn’t
checked, resizing the window has no effect on the size of the chart.

Chart Window
If you have a chart selected, this appears at the bottom of the View menu. It makes
Excel open the existing chart in a new chart window.

Insert Menu
If you want to insert something into your Excel documents, then this menu is your
best friend. If not, there’s no need to go to its parties.

Cells
Inserts a number of blank cells equivalent to the number you’ve first selected (see
page 410), and opens the Insert Cells window, which lets you set how those cells are
placed.

Rows
Inserts a number of blank rows equivalent to the number you’ve first selected, mov-
ing the selected rows down. If you have only one cell selected, Excel inserts only one
row.

Columns
Inserts a number of blank columns equivalent to the number you’ve first selected,
moving the selected columns to the right. If you only have one cell selected, Excel
inserts only one column.

Worksheet
Inserts a new worksheet into the currently open workbook to the left of the cur-
rently active or selected sheet.
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Chart
Opens the Chart window, which walks you through the creation of a chart, and then
it inserts your newly minted chart either into the currently active worksheet or into
a whole new sheet reserved for the chart alone.

List
Opens the List wizard, which walks you through the creation of one of Excel’s fancy
new List objects (see page 425).

Page Break
Inserts a page break above the currently selected cell. If the cell is adjacent to a manu-
ally placed page break, this command changes to Remove Page Break, which (as you
might guess) removes the break.

Function
Inserts the Paste Function window, from which you can select one of Excel’s func-
tions to insert into the currently active cell.

Name
The Name menu has five submenu choices that let you deal with names in Excel
worksheets. Names are plain-English ways of referring to a cell or selection of cells
(see page 423).

• Define. Opens the Define Name window, in which you can add or delete names
for a cell or group of cells.

• Paste. Opens the Paste Name window, which you can use to paste a named group
of cells into a formula. You can also paste a list of your defined names, including
the cells to which those names refer.

• Create. Opens the Create Names window, which lets you create names based on
labels in selected cells.

• Apply. Opens the Apply Names window, in which you can choose a name range
to replace a cell range inside a formula. That cell range has to match an existing
named cell ranges; otherwise, the Apply function doesn’t work.

• Label. Opens the Label Ranges widow, in which you can add and remove Label
Ranges as row labels or column labels. The labels you create let Excel automati-
cally apply them to formulas.

Comment
Inserts a comment attached to the selected cell or cells.

Picture
The Insert→Picture submenu lets you grab images from one of six sources. You can
read about them in detail starting on page 584, but here’s a summary:
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• Clip Art opens the Clip Art gallery and lets you select a bit of Office clip art to
insert.

• From File brings up an Open dialog box, which lets you find and insert your own
picture files.

• AutoShapes opens the AutoShapes toolbar; you can start drawing in your work-
sheet using the AutoShapes tools.

• Organization Chart opens Microsoft Organization Chart, which lets you create
and insert your own org charts into the currently active Excel worksheet.

• WordArt. Opens the Word Art window, in which you can create text art for inser-
tion into the currently active sheet.

• From Scanner or Camera. If you have the proper drivers installed (so-called
TWAIN drivers), this command can grab images from a digital camera or a scan-
ner and insert them into the currently active worksheet. (Very few cameras and
scanners actually work with this feature, however.)

Movie
Brings up an Open dialog box, in which you can select a QuickTime, AVI, or MPEG
movie to insert into the currently active sheet.

Object
Opens the Insert Object window, in which you can select one of the following Office
object types for insertion: a Clip Gallery item, an Equation object, a Microsoft Graph
2001 Chart object, Microsoft Organization Chart object, a Word 2001 Document
object, or a Word 2001 Picture object (see page 547).

Hyperlink
Opens the Insert Hyperlink window (see page 270), in which you can insert a new
hyperlink to a Web page, a document, or an email address. If there’s already a link in
the selected cell, this command opens the link for editing.

Format Menu
The Format menu gathers together all of the commands that you’re likely to use
while altering the formatting of your sheets and workbooks.

Cells
Opens the Format Cells window, in which you can choose all kinds of formatting
options for the selected cells. This menu item changes to reflect the type of object is
selected—Picture, Object, WordArt, or AutoShape—and then opens the appropri-
ate Format window. Keyboard shortcut: c-1

Row
This menu has four options that govern the appearance of the selected row or rows:

Excel Menus



662 office 2001: the missing manual

• Height. Opens the Row Height window, in which you can set the height of the
selected row or rows in pixels. If a worksheet is protected, this option is unavail-
able.

• AutoFit. Makes the selected row precisely as high as it needs to be to accommo-
date the tallest text in the row. Measured in pixels.

• Hide. Hides the selected row or rows from view (it doesn’t delete them).

• Unhide. Reveals any hidden rows.

Column
Like its sibling menu item, Format→Row, this menu has five options that let you
edit the appearance of the selected column or columns.

• Width. Opens the column width window, in which you can set the width of the
selected column or columns (measured in characters).

• AutoFit Selection. Makes the selected column precisely as wide as it needs to be
to accommodate the longest text in the column. Measured in characters.

• Hide. Hides the selected column or columns from view.

• Unhide. Reveals any hidden columns.

• Standard Width. Resets the selected column or columns to the default setting of
10 characters.

Selected Chart Area
If you have a chart selected, the Select Data Series menu item appears; it lets you
format the selected chart’s area. This menu item changes to reflect the various items
selected in the chart, including data series, plot areas, labels, and legends. All of
these open the appropriate Format window.

Sheet
This menu item has four submenus, each of which deals with a formatting aspect
for the active worksheet.

• Rename. Lets you rename the currently active sheet.

• Hide. Hides the selected sheet or sheets.

• Unhide. Reveals any hidden sheets in the workbook by presenting you with a list
of hidden sheets and letting you choose those you want shown.

• Background. Lets you select a graphics file to use as a background for the front-
most sheet.

AutoFormat
Opens the AutoFormat window, in which you can select formatting from a range of
presets for the selected cells or pivot table (see page 438).
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Conditional Formatting
Opens the Conditional Formatting window, in which you can change the selected
cells’ formatting based on conditions that you define—such as changing a cell’s text
color to red when its value is negative (see page 439).

Style
Opens the Style window, in which you can add, edit, or remove styles. Styles are a
saved set of formatting commands that you can apply to a cell or range of cells with
ease (see page 451).

Tools Menu
Although all menu items are tools, in a sense, most are grouped together because
they have some commonality (such as the Insert and Format menu items). The Tools
menu, on the other hand, is more general in nature. It includes a mix of text tools,
sharing tools, and other miscellaneous functions that are powerful but don’t neces-
sarily have a common thread.

Spelling
Runs a spell check on the frontmost spreadsheet (see page 516).

Dictionary
Opens the Office Dictionary floating window, which works like a real-world defini-
tions dictionary (except for the paper cuts).

AutoCorrect
Opens the AutoCorrect window, where you can edit what Excel tries to correct while
you type, such as changing “abbout” to “about.” You can add your own items for
Excel to AutoCorrect here (see page 84).

Share Workbook
Opens the Share Workbook window, in which you can change an ordinary work-
book into one that can be shared by many Excel users at once on a network. In this
window, you can turn workbook sharing on and off, and you can adjust how changes
to the shared workbook are treated (see page 475).

Track Changes
The Track Changes controls how Excel keeps tabs of changes to worksheets and
workbooks made by your collaborators. This menu has two submenu options:

• Highlight Changes. Opens the Highlight Changes window, in which you can turn
change tracking on and control which changes are highlighted.

• Accept or Reject Changes. Walks you through the changes that have been made
to a workbook, offering you the chance to accept or reject each.
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Merge Workbooks
Merges all of the changes from a series of shared workbooks into one single work-
book.

Protection
The Protection menu has three submenu choices that let you choose a level of pro-
tection for the currently open worksheet or workbook.

• Protect Sheet. Protects the frontmost sheet from changes to cells, charts, graph-
ics, or Visual Basic code.

• Protect Workbook Protects a workbook’s structure from changes such as delet-
ing, adding, hiding, or showing sheets; also keeps windows from being resized.

• Protect and Share Workbook Protects the workbook’s change tracking and shar-
ing status. If the workbook is not yet shared, Excel will ask you if you want to do
so when this item is selected. If it’s already shared, this command changes to
Unprotect Shared Workbook.

Flag for Follow Up
Opens the Flag for Follow Up window (see page 515), in which you can set a re-
minder attached to the currently open workbook. That reminder will pop up at the
time you specify to remind you to do something with the workbook in question
(provided an Office program is running at the time).

Goal Seek
Changes the value in a cell until a formula that uses that cell reaches a value you
specify (see page 500).

Scenarios
Opens the Scenarios Manager window, in which you can add, edit, merge, and de-
lete a series of scenarios, which are a way of playing “what if ” with an Excel work-
sheet (see page 501).

Auditing
The Auditing menu controls how formulas in a worksheet or workbook interrelate.
It has five submenu choices, all of which involve colorful arrows that appear on your
spreadsheet, pointing to cells that refer to each other (see page 489).

• Trace Precedents. Makes arrows point to a cell or cells that provide values for the
formula in the selected cell. Useful if you’re looking for where data comes from.

• Trace Dependents. Points to a cell or cells where the value in the selected cell is
being used.

• Trace Error. If the selected cell contains an error caused by a bad value in a cell
that its formula references, an arrow identifies the offending cell.

• Remove All Arrows. Removes all of the arrows drawn by auditing commands.
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• Show Auditing Toolbar. Hides or shows the Auditing toolbar.

Solver
Opens the Solver (an Excel add-in) that lets you attempt to solve an equation to
your liking by changing certain cell values (see page 504). In this window, you can
add, edit, and delete constraints, choose cells that the Solver is allowed to affect, and
set which cell is the target cell for the solution.

Calculator
Opens the new Formula Calculator, which you can use to quickly create formulas in
a neat touchpad format (see page 418).

Macro
For power users, the Macro command contains a lot of power (see page 517). It lets
you run and edit existing macros, make new ones, and gives you access to the Visual
Basic Editor. It has three submenu choices.

• Macros. Opens the Macro window, in which you can create, edit, or delete mac-
ros. You can also use this window to debug your macros by stepping into them
one step at a time.

• Record New Macro. Opens the Record Macro window, which lets you set options
for your new macro and then makes Excel watch your every move while it records
what it sees.

• Visual Basic Editor. For serious Excel junkies only. Opens the Visual Basic Editor,
in which you can write your own Excel macros using Microsoft’s Visual Basic
language.

Add-Ins
Opens the Add-Ins window, in which you can enable or disable various Add-Ins for
Excel. Add-Ins are conceptually similar to Photoshop plug-ins: they add new func-
tions to Excel (see page 517).

Customize
Opens the Customize window, in which you can decide what toolbars Excel should
display, create your own custom toolbars, and choose how Office presents itself vi-
sually.

Wizard
The Wizard menu gives you access to two of Excel’s wizards: Lookup and Condi-
tional Sum.

• Lookup. Opens the Lookup Wizard, the sole purpose of which is to walk you
through writing a formula that finds the value where a row and column inter-
sect.
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• Conditional Sum. Opens the Conditional Sum Wizard, which walks you through
writing a formula to take the sum of specific values depending on other values in
a list.

Data Menu
This menu’s commands all process the numbers and characters in your worksheet.

Sort
Sorts the selected rows alphabetically, by date, or numerically (see page 506).

Filter
The Filter menu item lets you hide rows of a list or selection according to criteria
that you specify. It has three items in its submenu.

• AutoFilter. Turns the AutoFilter pop-up menus at the top of a list object’s col-
umn. These pop-up menus contain commonly used filters (see page 435).

• Show All. Removes any filtering that’s been applied to a list.

• Advanced Filter. Opens the Advanced Filter window, which lets you create your
own filters for a selected range of cells.

Form
Opens a data form window, which you can use to view, edit, add, and delete data in
a list object (see page 512).

Subtotals
Figures out a subtotal and grand total for the selected labeled column (see page
506); automatically inserts the appropriate cells, moving the selected cells to the
right, and puts the spreadsheet in outline mode.

Validation
Opens the Data Validation menu, which lets you control what kind of data is en-
tered in a cell or cell. It also lets you choose a message to display when a cell is
selected (see page 508).

Table
Creates a data table based on a selected row and column input cell. Data tables are
useful to show how changing formula values affect a sheet’s data (see page 498).

Text to Columns
Opens the Convert Text to Columns Wizard, which walks you through the process
of converting a chunk of text in a cell (either separated by spaces or by commas)
into a series of columns (see page 508).
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Template Wizard
Opens the Template Wizard, which walks you through the five-step process of creat-
ing a database and template from an existing workbook (see page 483). The data-
base is typically embedded in an Excel workbook (and it’s linked to the workbook
you had open when running the Template Wizard), and the template that this Wiz-
ard creates is saved in the Templates folder.

Consolidate
Grabs data from one of several sources and consolidates it into a table for easy view-
ing. This command opens the Consolidate window, in which you can choose your
consolidation function, and add data sources (see page 509).

Group and Outline
The commands in this menu let you group data together and create outlines from
your groupings. By using grouping and outlining, you can hide and show detailed
data, grouping it in ways that help make sense of it (see page 513). For your group-
ing pleasure, the Group and Outline menu has seven submenu items.

• Hide Detail. If you have a summary row or column, this command hides the
detail rows or columns. For PivotTables, this command hides detail data in an
outer row or column field item.

• Show Detail. If you have hidden detail rows or columns, this command shows
them. For PivotTables, this command reveals detail data in an outer row or col-
umn field item.

• Group. Groups data (either cells or items in a PivotTable) together for easy analysis
and printing. Grouping cells automatically creates an outline in the frontmost
sheet.

• Ungroup. Ungroups formerly grouped data, separating group members into in-
dividual items.

• Auto Outline. Tells Excel to automatically create an outline, which it happily does
from the formulas and cell references in the given spreadsheet.

• Clear Outline. Removes outlining, of course. If you have selected a set of cells
that are in groups, then this command removes the outline in that area. If the
selected cells are not in a group, the outline is removed from the worksheet.

• Settings. Opens the Settings window, in which you can set some options for out-
lining and summarizing data in a worksheet.

PivotTable Report
Opens the PivotTable Wizard, which walks you through creating a PivotTable or
editing an existing PivotTable (see page 496).
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Get External Data
This menu has a collection of commands that link Excel to other data sources (such
as databases or Web-based data sources). There are seven commands in this sub-
menu.

• Run Saved Query. Pops up an Open dialog box, in which you can select a saved
data query to run. Excel ships with four pre-saved Web-based queries ready for
you to use (see page 494).

• New Database Query. Opens Microsoft Query (an optional install from the Value
Pack) or the Query Wizard, in which you can create your own database query,
you mad scientist, you.

• Import Text File. Imports an entire text file into the currently open worksheet.
This command opens the Text Import Wizard, which walks you through how
Excel will parse and place the data from the text file.

• Import from FileMaker Pro. Pops up an Open dialog box, in which you can choose
a FileMaker Pro database document to import data from (see page 490).

• Edit Query. Edits a query that you created using Microsoft Query to get at data
in an external database. If you have used the Import Text File command to bring
in a text file, this menu item changes to Edit Text Import, and performs accord-
ingly.

• Data Range Properties. Opens the External Data Range Properties window, which
lets you change some of the settings for an imported bit of external data (such as
whether the query definition is saved, how data is refreshed, and how data is laid
out).

• Parameters. Lets you set options for a parameter query, a special kind of query
that asks you for some information that it will use to retrieve data from the
database’s tables.

Refresh Data
Refreshes the data in a PivotTable if the table’s source data has changed.

Chart Menu
The Chart menu appears only when a chart is selected in Excel; it replaces the Data
menu on the menu bar. Many of these options duplicate settings in the chart wiz-
ard, giving you the chance to revisit some of those choices.

Chart Type
Opens the Chart Type window, in which you can choose a new chart type for the
selected chart (see page 454).

Source Data
Opens the Source Data window, in which you can choose a different range of cells
from which the chart draws its data.
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Chart Options
Opens the Chart Options window, in which you can set all kinds of options for the
selected chart. These settings cover the chart’s titles, labels, gridlines, legends, and
axes.

Location
Opens the Chart Location window, in which you set where the chart is placed: as a
new sheet or as an object in an existing sheet.

Add Data
Opens the Add Data window, which lets you add additional cells to the chart.

Add Trendline
Opens the Add Trendline window, in which you can a trend line to your chart, or
change one that’s already there (see page 465).

3-D View
Puts up the 3-D view window, which lets you manipulate your 3D chart as if it were
a real-world, solid item by rotating it, scaling it, or changing its elevation. If the
selected chart isn’t a 3D chart, this menu item isn’t available.

Window Menu
These commands help you manage your spreadsheet windows.

New Window
Opens a new window on the same file that’s currently open—a duplicate view of the
same spreadsheet. This arrangement lets you view two (or more) places in the same
file at the same time, scrolled to different spots and zoomed independently.

Arrange
Arranges all open windows so that at least a portion of each is visible—which makes
switching or dragging data between open files much easier. An Arrange Windows
window opens, where you can set how those windows are arranged.

Hide
Hides the frontmost workbook window without closing it.

Unhide
Displays a list of windows that have been hidden with the Hide command, which
you can then Unhide.

Split
Splits the active window horizontally and vertically into four, independently scroll-
ing panes. If the currently active window has been split, this menu command changes
to Remove Split.
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Freeze Panes
If your sheet has been split into two or four panes, this command freezes the top
pane, the left pane, or both. That way, those panes stay in place while you scroll the
lower right panes—it keeps column and row titles visible while you scroll through
your worksheet. (None of this affects how the sheet prints.) This command changes
to Unfreeze Panes if you have already frozen the panes on the sheet.

Window List
The last item on the Window menu is a list of currently open workbook windows.
You can switch between them by selecting their names from this menu.

Help Menu
These commands are the same as they are in Entourage, as described earlier in this
appendix (see page 653).

PowerPoint Menus
PowerPoint has many commands in common with the other Office programs. What
unique menus it has are dedicated to manipulating slides, text, and images, which is
what PowerPoint does so well.

File Menu
PowerPoint’s File menu, of course, is for working with files on your hard drive—
whether that’s creating new files, saving them, or printing them.

Project Gallery, New Presentation, Open, Close, Save, Save As
These commands work exactly as they do in Excel (see page 639); the only distinc-
tion here is the wording of the New command (New Presentation).

Save as Web Page
Saves the frontmost PowerPoint presentation as a series of Web pages, converting
graphics and graphs to the proper kinds of graphics files and saving all of the data in
HTML tables (see page 567).

Make Movie
Creates a QuickTime movie from the frontmost open presentation (see page 565).

Web Page Preview
Shows you what your presentation looks like as a Web page. It opens a temporary
Web-page version of your file in your browser.

Page Setup, Print
These commands work just as they do in Excel (see page 654).
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Send To
PowerPoint’s Send To menu lets you send the currently open presentation directly
to:

• Mail Recipient. Attaches the frontmost presentation as a file attachment to an
outgoing Entourage email message, so that you can send it to whomever you like.

• Microsoft Word. Sends the frontmost presentation’s outline to Word, where you
can edit it.

• Genigraphics. Converts your presentation into the proper format for transmis-
sion to Genigraphics, a company that specializes in creating high-resolution print-
outs of presentations (posters, 35 mm slides, and the like). (May be dimmed if
you didn’t select this option when installing Office.)

Properties, Quit
These commands work just as they do in Excel (see page 655).

Edit Menu
The Edit Menu gathers together all of PowerPoint’s Edit tools into one handy place.
Many of these commands are similar to those in other Office programs’ Edit menus,
but they aren’t all the same.

Undo, Repeat/Redo, Cut, Copy, Paste
These commands work just as they do in Excel (pages 655-656).

Paste Special
Opens the Paste Special window, which you can use to paste the contents of the
clipboard into the presentation as a linked or embedded file. It also offers some
formatting options when pasting such a file.

Paste as Hyperlink
Pastes the clipboard contents (if you’ve copied an Internet address or some material
from Word) into the frontmost PowerPoint presentation as a hyperlink.

Clear
Clears the selected item from the frontmost presentation document.

Select All
Selects all objects on the screen. If the cursor is currently in an active text object,
selects all of the text inside that object. Keyboard shortcut: c-A.

Duplicate
Duplicates the selected object, placing the copy slightly below and to the right of the
original. Duplicating an item does not put it on the clipboard. Keyboard shortcut:
c-D.
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Delete Slide
Deletes the current slide (Normal or Notes view) or the selected slides (in Slide
Sorter view).

Find
Opens PowerPoint’s Find window, which you can use to search for certain keywords
or formatting in Office files on your hard drive. Keyboard shortcut: c-F.

Replace
Searches for specific text or formatting and replaces it with other text or formatting
that you specify. Keyboard shortcut: c-H.

Go to Property
Although few living souls have ever tried it, PowerPoint offers a unique feature that
lets you flag certain blobs of text as having been proofread, approved by the client,
and so on. To flag a piece of text in this way, drag through it; choose File→Properties→
Custom tab; choose from the list of properties (Disposition, Department, and so
on); turn on “Link to content”; click Add; and then click OK.

After having marked up dozens of text swatches in a slide show this way, the Edit→
Go To Property command is your ticket to finding those characteristics again. When
you choose this command, a tiny dialog box appears, listing all of the flags you’d set
up in this way; by double-clicking one, you jump directly to the corresponding blob
of text, making it easy to (for example) round up all the text blobs that have yet to be
approved before going live with the presentation.

Object
If you’ve been editing the text inside a text box or table, it’s a darned nuisance to
have to switch to the arrow tool just to adjust, say, the placement, formatting, or size
of that text box or table. This command neatly toggles back and forth between (a)
placing the insertion point inside the selected text box or table and (b) selecting the
text box or table itself. It saves you a couple of mouse clicks when doing frantic
alternation between editing and tweaking.

Preferences
Opens PowerPoint’s Preferences window.

View Menu
The View menu is home to the commands that govern what you see when you’re
working with PowerPoint: its view mode, whether the presentation is in color or
grayscale, and what toolbars and palettes are showing.

Normal, Slide Sorter, Notes Page, Slide Show
Switches to the corresponding view; see page 523 for details on these views.

PowerPoint Menus



appendix c: office 2001, menu by menu 673

Master
The Master menu takes you to the various master elements in a presentation (see
page 532). It has four submenu choices:

• Slide Master. Takes you to the Slide Master for the currently active presentation,
in which you can add elements, or make formatting changes, that will show up
on every slide.

• Title Master. Takes you to the Title Master, where you can tweak the settings for
the special Title Master slide.

• Handout Master. Takes you to the Handout Master, which lets you tweak settings
that will appear on every handout page in the presentation.

• Notes Master. Takes you to the Notes Master, which lets you change settings for
every notes page in the presentation.

Grayscale
Takes your presentation into, or out of, Grayscale mode, temporarily removing all
color—a useful preview if you plan to print on a standard black-and-white laser
printer. If you Control-click your presentation while in Grayscale mode, you get a
Grayscale contextual menu that offers various wacky inversions of the black/white/
gray color scheme.

Slide Miniature
Hides or shows the Slide Miniature floating window, which shows a thumbnail im-
age of the current slide.

Formatting Palette
Hides or shows the Formatting Palette (see page 537).

Toolbars
Hides or shows any of 13 PowerPoint toolbars: Standard, Formatting, Animation
Effects, Common Tasks, Drawing, Movie, Outlining, Picture, Reviewing, Tables and
Borders, Visual Basic, Web, and WordArt. The 14th option, Customize, opens up the
Customize window, in which you can turn on or off even more PowerPoint toolbars
or create your own.

Ruler
Hides or shows PowerPoint’s rulers (for aligning objects on the page).

Guides
Turns the horizontal and vertical guide lines on or off (useful T-square-like lines
that help you align objects on your slide with each other). Keyboard shortcut: c-G.

PowerPoint Menus



674 office 2001: the missing manual

Office Clipboard
Shows or hides the Office Clipboard, which, once shown, appears in every open
Office application (see page 53).

Header and Footer
Opens the Header and Footer window, in which you can create text that repeats on
the top or bottom of every slide.

Comments
Shows or hides any comments (“sticky notes”) that have been placed in PowerPoint
slides by you or your detractors.

Zoom
Opens the Zoom window, where you can choose from one of six preset values for
magnifying or reducing the onscreen representation of your slides, or enter your
own zoom percentage.

Insert Menu
Use the commands in this menu to add things to your PowerPoint presentations or
to individual slides.

New Slide
Creates a new slide after the selected slide. Keyboard shortcut: c-M.

Duplicate Slide
Duplicates the active slide; places the duplicate after that slide. Although no key
equivalent is given in the menu for this command, pressing c-Shift-D is, in fact, the
keyboard shortcut.

Slide Number
Adds the slide number to a text box on the active slide (not every slide—you’ll have
to use a header or footer for that purpose).

Date and Time
Opens the Date and Time window, which you can use to add the current date and
time in one of several formats to the current slide. If you want to add the date and
time to every slide, again, use a header or footer.

Tab
Inserts a tab into text at the insertion point, just as though you’d pressed the Tab key.

Symbol
Calls up the Symbol window (which is similar to the Key Caps window), in which
you can choose a symbol character from any of the currently installed symbol fonts—
or from the symbols contained in a normal font.
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Comment
Inserts a comment into the currently active slide, as though it’s a “sticky note.”

Slides from File
Lets you pull slides out of another PowerPoint file to insert into the currently active
presentation.

Slides from Outline
Imports a Word outline and creates slides (and slide text) from it. Each first-level
item is given its own new slide (see page 531).

Picture
The Insert→Picture submenu lets you grab images from one of seven sources, as
described in Chapter 18.

Text Box
Inserts an empty text box on the active slide.

Movies and Sounds
Gives you five choices that you can use to get motion and audio into your presenta-
tions.

• Movie from Gallery. Opens the Clip Gallery to show motion clips, which are
really just animated GIFs.

• Movie from File. Pops up an Open dialog box, in which you can choose a Quick-
Time movie file to insert into your presentation.

• Sound from Gallery. Opens the Clip Gallery to show all audio clips that you can
insert into your presentation.

• Sound from File. Pops up an Open dialog box, in which you can choose an audio
file to insert into your presentation.

• Play CD Audio Track. Inserts a track from the currently mounted audio CD so
that you can use it as a soundtrack.

• Record Sound. Lets you record a sound, using your Mac’s microphone, that can
be used in your presentation (see pages 544 and 564).

Chart
Launches Microsoft Graph, which you can use to create and insert a chart into your
presentation (see page 608).

Table
Opens the Insert Table window, in which you can specify the size of the table that
gets inserted when you select this command (see page 542).
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Object
Opens the Insert Object window, in which you can select one of the following Office
object types for insertion: a Clip Gallery item, an Equation object, a Microsoft Graph
2001 Chart object, Microsoft Organization Chart object, a Word 2001 Document
object, or a Word 2001 Picture object (see page 547).

Hyperlink
Opens the Insert Hyperlink window, in which you can insert a new hyperlink to a
Web page, a document, or an email address (see page 270). Keyboard shortcut: c-K

Format Menu
This menu contains all of PowerPoint’s formatting commands, which let you ma-
nipulate fonts, text alignment and spacing, and colors.

Font
Opens the Font window, in which you can set all kinds of font options for the cur-
rently selected text: the font, size, style, color, and effects.

Bullets and Numbering
Opens the Bullets and Numbering window, in which you can select a style for your
bulleted or numbered items. You can also use this window to insert a picture or
character of your own choosing to use as a bullet (see page 540).

Alignment
Aligns the selected text in one of four ways: left, center, right, or justified.

Line Spacing
Opens the Line Spacing window, in which you can set the line spacing as well as the
space before or after each paragraph.

Change Case
Opens the Change Case window, where you can change the capitalization of the
selected text: sentence case, lowercase, uppercase, title case, and toggle case.

Replace Fonts
Lets you replace one specified font in your presentation with a different font, glo-
bally, wherever it may occur—a great tactic when you move your file to a different
machine that doesn’t have the fonts you used originally.

Slide Layout
Opens the Slide Layout window, where you can choose from one of 24 canned lay-
outs for text and graphics on the active slide.
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Slide Color Scheme
Pops open the Color Scheme window, in which you can choose from a set of stan-
dard color schemes or create a custom one.

Background
Opens the Background window, in which you can choose a background fill color for
the current slide (or for all of the slides in the presentation).

Apply Design Template
Brings up an Open dialog box showing PowerPoint’s design templates. You can choose
one of the files in that window to provide a design template, or you can select an
existing PowerPoint presentation and take its design template.

Colors and Lines
Opens the Colors and Lines section of the Format AutoShape window, in which you
can select a fill color, a line color and style, and an arrow style for your selected line
or shape.

[Object]
This command’s name changes to match whatever you’ve highlighted on your slide—
Picture, AutoShape, or whatever; it opens the corresponding Format window.

Tools Menu
Most of these commands work just as they do in the other Office programs.

Spelling, Dictionary, AutoCorrect, Flag for Follow Up
These commands work just as they do in Excel (see page 663).

Language
Flags the selected text as being in a given language, whether it actually is or not. The
Office spelling checker will use the appropriate language dictionary (and you’ll get
language-appropriate AutoText entries) as a result (see page 77).

Meeting Minder
Opens the Meeting Minder floating window, in which you can enter notes during a
presentation for later use (see page 556).

Macro
The Macro menu holds the two most important automation commands in Power-
Point: Macros (which opens the macro window, where you can create, edit, or delete
macros), and Visual Basic Editor (which opens the Visual Basic Editor module, where
you can write your own macros).
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Add-Ins
Opens the Add-Ins window, where you can turn on PowerPoint plug-in features.
(At this writing, none exist; Office doesn’t come with any.)

Customize
Opens the Customize window, in which you can decide what toolbars PowerPoint
should display, create your own custom toolbars, and choose how Office presents
itself visually (see Chapter 17).

Slide Show Menu
This menu contains all of the slide show-related menu commands, used for prepar-
ing and running a slide show.

View Show
Starts the slide show from the current slide.

Rehearse Timings
Runs through your slide show, keeping track of the amount of time that it takes to
show each slide. Those times can be saved with the presentation so that it runs just
as long as it did during rehearsal (see page 554).

Record Narration
Runs through your slide show while recording your voice, making a complete pre-
sentation out of what you record. The audio plays back as a series of audio clips to
the timings that you set while recording your narration (see page 564).

Set Up Show
Opens the Set Up Show window, in which you can set options for the currently open
presentation (see page 554).

Action Buttons
Lets you add action buttons to your slides. You can choose the kind of action button
(mostly used for navigating, playing media clips, or opening files) from the sub-
menu: custom, home, help, information, previous slides, next slide, first slide, last
slide, last slide viewed, document, sound, and movie. Page 558 has details.

Action Settings
If you have an Action Button selected, this command opens the Action Settings win-
dow, in which you can decide what the selected Action Button does.

Animations
Lets you choose an animation for the selected item from the submenu (see page
561).
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Animation Preview
Previews the animation in the little floating Animation Preview window so you can
see how it looks—and sounds, if it has audio.

Slide Transition
Opens the Slide Transition window in which you can select a transition between
slides, and you can tweak how it looks (see page 550).

Hide Slide
Hides the current slide so that it’s not displayed during a slide show (see page 560).

Custom Shows
Opens the Custom Shows window, in which you can add, edit, or remove custom
slide show variations on the currently open presentation (see page 560).

Window Menu
The Window menu commands let you shuffle and manipulate multiple PowerPoint
windows.

New Window
Opens a new window showing the same PowerPoint file—in essence, a second view
of the same document. This arrangement lets you view two (or more) places in the
same file at the same time, scrolled to different spots and zoomed independently.

Arrange All
Arranges and resizes all open windows so that you can see each. It’s great for drag-
ging items between them.

Fit to Page
In Slide Sorter mode, this command resizes the active presentation to expand to fill
the screen, leaving room for toolbars and other elements around the outside.

Cascade
Resizes and rearranges all open windows so that one is on top of the next, and you
can see the title bar and a small proportion of each window.

Next Pane
Rotates clockwise to the next window pane, making it active.

Window List
The last item on the Window menu is a list of currently open PowerPoint windows.
You can switch between them by selecting their names from this menu.

Help Menu
See “Help Menu” on page 653.
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Word Menus
Word’s menus, once again, offer many functions described earlier in this appendix,
but there are significant differences.

File Menu
Word comes equipped with a File menu (like almost all other Mac programs), which
is mainly used for working with files on your hard drive—whether that’s creating
new files, saving them, or printing them.

Project Gallery, New Blank Document, Open, Close, Save, Save As
These commands work just as they do in Excel (pages 639-640).

Open Web Page
Prompts you for a Web page address, after which Word downloads that Web page
from the Internet into a blank Word document.

Save as Web Page
Converts the frontmost Word document into a Web page, converting graphics into
the appropriate graphic formats (see page 277).

Versions
Opens the Versions window, in which you can save and access multiple versions of
the same document (see page 176).

Web Page Preview
Shows you what your document would look like as a Web page. It opens a tempo-
rary Web page conversion of your file in your browser of choice.

Page Setup, Print
See page 641.

Print Preview
Opens up the Print Preview window to show you how a Word document will look
when you print it; lets you adjust margins (see page 42).

Send To
Word’s Send To submenu (see page 48) has two items: Mail Recipient (as Attach-
ment), and Microsoft PowerPoint. Mail Recipient (as Attachment) attaches the cur-
rently open Word document to an Entourage email message, ready to address and
send. Microsoft PowerPoint sends the currently open Word outline to PowerPoint
to serve as the basis for a presentation.

Properties, Quit
See page 655.
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Edit Menu
The Edit Menu gathers together all of Word’s Edit tools into one handy place. Many
of these commands are similar to those in other Office programs’ Edit menus.

Undo, Repeat/Redo, Cut, Copy, Paste
See pages 655-656.

Paste Special
Opens the Paste Special window, which you can use to paste the contents of the
clipboard into your Word file in certain specially formatted ways (see page 53).

Paste as Hyperlink
Pastes the clipboard contents into the frontmost Word document as a hyperlink
(see page 54).

Clear
Clears (or removes) the selection from the document.

Select All
Selects all text and objects in the document, ready for (for example) copying or
deleting. Keyboard shortcut: c-A.

Find
Opens Word’s Find window, which you can use to search the open document for
text or formatting (see page 64). Keyboard shortcut: c-F.

Replace
Searches for specific text or formatting and replaces it with other text or formatting
that you specify (see page 64). Keyboard shortcut: c-H.

Go To
Opens the Go To portion of the Find and Replace window (see page 61), in which
you can enter a place in the frontmost Word document to go to, such as a specific
page, section, line number, footnote, or endnote. Keyboard shortcut: c-G.

Links
Pulls up a window that shows information about every link in the currently active
document (see page 311). If the document doesn’t have any links to other docu-
ments, this option is dimmed.

Object
Lets you edit an embedded object, such as a Microsoft Graph object or a Microsoft
Organization Chart object (see page 547).
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Preferences
Opens Word’s Preferences window.

View Menu
This menu’s commands govern what view mode the windows are in, what toolbars
are shown, and so on.

Normal, Online Layout, Page Layout, Outline, Master Document
Switches among Word’s various document views; see page 34 for descriptions.

Formatting Palette
Hides or shows the Formatting Palette (see page 97).

Toolbars
Shows a submenu of 19 Word toolbars that you can hide or show by selecting them
here. The last option, Customize, opens up the Customize window, in which you
can turn on or off even more Word toolbars or create your own toolbars (see page
575).

Ruler
Hides or shows the ruler in the currently active document (see page 22).

Document Map
Hides or shows the document map—a vertical listing of headings in the currently
open Word document—for quick navigation (see page 203).

Office Clipboard
Shows or hides the Office Clipboard (see page 53)..

Word 5.1 Menus
Remakes Word’s menus and toolbars so that they resemble those of the beloved
Word 5.1 for the Mac.

Header and Footer
Switches the currently active Word document to Header and Footer mode (and shows
the Header and Footer toolbar), in which you can enter headers or footers that will
show up at the top or bottom of every page (see page 183).

Footnotes
Shows footnotes, which also makes them available for editing (see page 183).

Comments
Shows or hides the comments pane (see page 167) and Reviewing toolbar.
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Reveal Formatting
Hides or shows the Reveal Formatting mode, which pops up a balloon with all kinds
of details about the formatting where you click (see page 112).

Full Screen
Turns Full Screen mode on or off. In this mode, almost all of Word’s extraneous
elements (the status bar, the toolbar, and the like) disappear, leaving the entire screen
for the enjoyment of your creative work.

Zoom
Lets you magnify or reduce the onscreen display of your document.

Insert Menu
This collection of Word commands lets you insert specialized text, entire documents
or other pictures and objects into your Word documents.

Break
Inserts one of six kinds of breaks into the Word document that interrupt your text
at the insertion point: page breaks, section breaks, column breaks, and so on (see
page 138).

Page Numbers
Opens the Page Numbers window, which lets you choose a place for page numbers
that update automatically (see page 193).

Date and Time
Opens the Date and Time window, from which you can insert the current date and
time in a variety of formats. The date and time appear at the insertion point, and it
can be made to update automatically to the current date and time whenever the
document is printed.

AutoText
The AutoText menu (see page 87) contains 11 commands that let you automatically
enter canned bits of text (such as letter salutations) at the insertion point. The Auto-
Text menu items are actually categories, with these submenus:

• AutoText. Opens the AutoCorrect window to the AutoText tab, where you can
enter your own text entries.

• New. Creates an AutoText entry from the selected text. Keyboard shortcut: c-Shift-
Return.

• Attention Line. Inserts either Attention: or ATTN: into your document

• Closing. Offers 13 ways to close a letter.

• Contact. Lets you insert the name of someone in your Entourage Address Book.
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• Header/Footer. Lists 10 entries appropriate for headers and footers, such as page
numbers, the file name, and a “Confidential” stamp.

• Mailing Instructions. Offers eight mail-related entries. Keyboard shortcut: c-Shift-
return.

• Reference Line. Inserts reply-style entries.

• Salutation. Lists four correspondence-starters.

• Signature. Inserts your name (or whatever signature you like).

• Subject Line. Inserts Subject: into your document.

Field
Opens the Field window, in which you can insert a Word field (self-updating text
code) at the insertion point (see page 213).

Symbol
Calls up the Symbol window so that you can insert a special character, like ™ or ©
(see page 186).

Comment
Inserts a comment into the currently active document and opens the Reviewing
toolbar (see page 167).

Footnote
Opens the Footnote and Endnote window, in which you can enter footnote and
endnote information (see page 183).

Caption
Opens the Caption window, which you can use to insert a picture caption at the
insertion point (see page 221).

Cross-reference
Opens the Cross-reference window, which lets you insert cross references to items in
the document (see page 224).

Index and Tables
Opens the Index and Tables window, in which you can create various indexes, table
of contents entries, and authority citations (see page 232).

Picture
The Insert→Picture submenu lets you grab images (clip art, scans, and so on) from
one of seven sources, as described in Chapter 18.
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HTML Object
This menu is meant to help build Web pages, a secondary Word skill described at
length in Chapter 7. It has nine submenus:

• Background Sound. Inserts a sound of your choice that will be played back when
the page is viewed in a browser.

• Scrolling Text. Adds text that scrolls annoyingly when your page is viewed in a
Web browser.

• Checkbox. Inserts an HTML checkbox (complete with name and value) at the
insertion point.

• Option Button. Inserts an HTML option button (or radio button) at the inser-
tion point.

• List Box. Inserts an HTML list box at the insertion point.

• Textbox. Inserts an HTML text box at the insertion point.

• Submit. Inserts an HTML button (titled Submit by default) at the insertion point.

• Reset. Inserts an HTML Reset button at the insertion point (for resetting a form).

• Hidden. Inserts a hidden HTML field at the insertion point.

Text Box
Lets you draw a floating text box (see page 144).

Movie
Brings up an Open dialog box, in which you can select a QuickTime, AVI, or MPEG
movie to insert into the document.

File
Lets you insert one Word file into another—at the insertion point—just as though
you’d copied and pasted it.

Object
Opens the Insert Object window, in which you can select one of several Office ob-
ject types for insertion (see page 547).

Bookmark
Inserts a bookmark in the currently open document. The bookmark can be used to
mark text, pictures or tables (see page 218).

Hyperlink
Opens the Insert Hyperlink window, in which you can insert a new hyperlink to a
Web page, a document, or an email address (see page 270). Keyboard shortcut: c-K.
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Format Menu
This menu contains all of Word’s formatting commands, which let you work with
text controls, alignment, and spacing.

Font
Opens the Font window, where you can make all kinds of marvelous tweaks to the
type choices of the selected (or about-to-be-typed) text. Keyboard shortcut: c-D.

Paragraph
Opens the Paragraph window, where you can change paragraph-level formatting
options (such as line spacing and indents). Keyboard shortcut: c-Option-M.

Document
Opens the Document window, where you can change document-level formatting
options (such as margins and how sections begin).

Bullets and Numbering
Opens the Bullets and Numbers window, in which you can control how bulleted
and numbered lists look (see page 105).

Borders and Shading
Opens the Borders and Shading window, where you can add and change borders
and shaded areas in your Word document.

Columns
Opens the Columns window, where you can set the number of columns used in the
current document (see page 140). You can also control the column width and spac-
ing in this window.

Tabs
Opens the Tabs window, in which you can add, edit, and remove tab stops in the
currently open Word document (see page 115).

Drop Cap
Lets you add a drop cap to the currently open Word document (see page 104). You
can choose from one of three styles in the window that pops up.

Text Direction
Lets you choose from three text direction orientations: left to right, top to bottom,
or bottom to top. For use primarily in table cells (see page 111).

Change Case
Opens the Change Case window, where you can change the capitalization of the
selected text: sentence case, lowercase, uppercase, title case, and toggle case.
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AutoFormat
Automatically adds formatting according to the AutoFormat rules that you set to
the currently open Word document (see page 92).

Theme
Lets you choose a theme (complete with background and text colors, and graphical
bullets) for the current Word document (see page 136).

Style
Lets you add, edit, and remove styles in the currently open Word document (see
page 129).

Background
Hides or shows the Background toolbar, which you can use to add a little color to
your Word document (see page 137).

[Object]
This menu’s wording reflects whatever’s selected in the document window (Picture,
AutoShape, and so on). It opens the corresponding Format window.

Font Menu
This menu lists every font you have installed. To select a font, choose its name. Word
renders the font names in the actual font, so that you can see what you’re selecting
(see page 99).

Tools Menu
The Tools menu includes a mix of text tools, sharing tools, and other miscellaneous
functions.

Spelling and Grammar
Checks the document for spelling and grammar errors; if Word finds any question-
able items, pops open the Spelling and Grammar window to give you the opportu-
nity to correct them (see page 71). Keyboard shortcut: c-Option-L.

Thesaurus
Opens Word’s Thesaurus window, which lets you find synonyms or antonyms for
the selected word. Keyboard shortcut: c-Option-R.

Hyphenation
Hyphenates the currently active Word document, which gives better spacing be-
tween words in individual lines (see page 142).

Dictionary
Opens the Word dictionary, in which you can look up a word’s definition (see page
30).
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Language
Flags selected text as being in a given language. The advantage of doing this is that
Word will thereafter apply the appropriate language dictionary for spelling checks
and AutoCorrect entries (see pages 77 and 89).

Word Count
Counts up the statistics for the currently open Word document: the number of words,
lines, characters, and paragraphs.

AutoSummarize
Tries to summarize the currently open Word document down to its salient points.
The

AutoCorrect
Opens the AutoFormat window, in which you can determine what Word tries to
automatically correct when it thinks it sees an error in your typing. It also lets you
enter AutoText items that will fill in automatically as you type, and it lets you set the
automatic formatting that is applied to your Word documents both as you type and
if you select the AutoFormat command.

Track Changes
The Track Changes controls how word keeps tabs of changes to documents. This
menu has three submenu options: Highlight Changes and Accept or Reject Changes.

• Highlight Changes. Opens the Highlight Changes window, in which you can turn
change tracking on, plus you can control which changes are highlighted.

• Accept or Reject Changes. Walks you through the changes that have been made
to a workbook, and accept or reject each.

• Compare Documents. Compares the open document with the original saved ver-
sion of that same document, and shows any changes that you’ve made.

Merge Documents
Merges changes that have been tracked in the currently open Word document into
the document that you choose.

Protect Document
Keeps people from making the kinds of changes that you specify to a document. You
can optionally enter a password to protect the currently open document from those
changes.

Flag for Follow Up
Opens the Flag for Follow Up window, in which you can set a reminder attached to
the currently open Word document. That reminder will pop up at the time you
specify to remind you to do something with the document in which it’s embedded.
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Data Merge Manager
Opens the Data Merge Manager palette, which you can use to take control over your
data merge operations (such as mail merges for mass mailings).

Envelopes
Helps you create an envelope, including things such as the delivery address and re-
turn address. It also has an option to do a data merge, so that you can draw ad-
dresses for your envelopes from a data file.

Labels
Lets you use Word to create mailing labels of all kinds. This command takes advan-
tage of Word’s plethora of mailing label templates, and it lets you format those la-
bels for either dot-matrix or laser printing.

Letter Wizard
Opens the Letter Wizard, which walks you through the process of creating a letter
suitable for mailing to businesses, friends, or even writing crank letters to the gov-
ernment.

Address Book
Opens the Office Address Book window (which looks suspiciously like the Entou-
rage Address Book), in which you can quickly look up contact information.

Macro
For power users, the Macro command contains a lot of power. It lets you run and
edit existing macros, make new ones, and gives you access to the Visual Basic Editor.
It has three submenu choices.

• Macros. Opens the Macro window, in which you can create, edit, or delete mac-
ros. You can also use this window to debug your macros by stepping into them
one step at a time, or even set options for your macros.

• Record New Macro. Opens the Record Macro window, which lets you set options
for your new macro and then makes Word watch your every move while it records
what it sees.

• Visual Basic Editor. This item opens the Visual Basic Editor, in which you can
write your own Word macros using Microsoft Visual Basic.

Templates and Add-Ins
Opens the Templates and Add-Ins window, in which you can attach a different tem-
plate to the currently open Word document, plus, you can use this window to enable
or disable various Add-Ins for Word. Add-Ins are conceptually similar to Photoshop
plug-ins.
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Customize
Opens the Customize window, in which you can decide what toolbars Word should
display, create your own custom toolbars, change keyboard combinations, and choose
how Office presents itself visually

Table Menu
Word’s Table menu contains a variety of commands to help you draw the perfect
table to hold your precious data.

Draw Table
Opens the Tables and Borders toolbar, which you can use to draw tables in your
Word documents.

Insert
This menu has several options that let you take a little more conservative approach
to table creation. It has six options.

• Table. Opens the Insert Table window, in which you can specify the size and
characteristics of your new table.

• Columns to the Left. Adds a column to the left of the insertion point in the cur-
rently active table. If you have more than one column selected, this command
will insert the same number of columns to the right of the insertion point.

• Columns to the Right. Adds a column to the right of the insertion point in the
currently active table. If you have more than one column selected, this command
will insert the same number of columns to the right of the insertion point.

• Rows Above. Inserts a row above the insertion point in the currently active table.
If you have more than one row selected, this command will insert the same num-
ber of rows above the insertion point.

• Rows Below. Inserts a row below the insertion point in the currently active table.
If you have more than one row selected, this command will insert the same num-
ber of rows below the insertion point.

• Cells. Inserts the number of cells that you have selected into the currently active
table. It also opens the Insert Cells window, in which you can specify how things
move around to make room for those cells.

Delete
Sometimes you want to remove a table from a document, and this menu (with its
four submenu choices) has you covered.

• Table. Deletes the currently selected table.

• Columns. Deletes the currently selected columns.

• Rows. Deletes the currently selected rows.
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• Cells. Deletes the currently selected cells, and it gives you the option of how you
want to shift the remaining cells to take up the room left vacant by the now miss-
ing-cells.

Select
That’s right—there’s a special Select menu item for use with tables, and it has four
submenu options to help you select just the portions of the table with which you
want to work.

• Table. Selects the entire table. If the insertion point isn’t in a table, this option is
left blank.

• Column. Selects the column in which the insertion point is located.

• Row. Selects the row in which the insertion point is located.

• Cell. Selects the cell in which the insertion point is located.

Merge Cells
Merges two or more adjacent selected cells (including the data contained in those
cells) into one large cell.

Split Cells
Splits a cell into the number of rows and columns that you set.

Split Table
Plays King Solomon and splits a table at the insertion point, placing a paragraph
mark between the two new tables.

Table AutoFormat
Automatically formats the currently selected table using one of a number of color
schemes, line thicknesses, and column widths. You get to select an AutoFormat scheme
when you select this item.

AutoFit
The AutoFit menu item lets you automatically resize a table to fit a variety of factors.
This menu item has five submenu selections.

• AutoFit to Contents. Makes the table’s columns resize themselves to fit the text
or numbers that you type in.

• AutoFit to Window. Makes the table resize itself to fit a Web browser window.
Useful for creating tables meant for the Web.

• Fixed Column Width. Makes the width of the selected columns a fixed value.
That way, they won’t vary in size.

• Distribute Rows Evenly. Makes the selected rows the same height.

• Distribute Columns Evenly. Makes the selected columns the same width.
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Heading Rows Repeat
Makes the selected row a heading row, which means that it will repeat at the top of a
page if the table that it’s in spans more than one page.

Convert
The two commands in the Convert submenu let you move text into tables and back
out again.

• Convert Text to Table. Converts the selected text into a table, placing the text in
one or more of the table’s cells.

• Convert Table to Text. Converts the selected table cells into regular text.

Sort
Opens the Sort window, in which you can sort your table’s contents alphabetically,
numerically, and so on.

Formula
Sort of a mini-Excel. This command lets you insert a formula into the currently
active cell to do basic calculations.

Gridlines
Hides or shows the table’s dotted gridlines. These gridlines help you see what you’re
doing in your current table.

Table Properties
Opens the Table Properties window, in which you can set all kinds of options for the
currently selected table.

Window Menu
The Window menu provides a home for all menu commands that are window re-
lated.

New Window
Opens a new window on the same file that’s currently open. That way, you can view
two (or more) places in the same file at the same time.

Arrange All
Arranges all open windows so that you can see each one. They’re stacked vertically.
This makes it easy to drag items between them.

Split
Splits the currently active Word window into two independently scrolling panes. If
the window is already split, this menu command changes to say Remove Split, which
removes the split screen effect (see page 22).
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Window List
The last item on the Window menu is a list of currently open Word documents. You
can switch between them by selecting names from this menu.

Work Menu
The Work menu is meant to be your customizable menu, to which you can add
various documents that you want to be just a menu selection away (see page 19).

Add to Work Menu
Adds the frontmost Word document’s name to the Work menu. To remove it from
the Work menu, press c-Option-hyphen, which turns the cursor into a big minus
sign; then select the item that you want to remove from the Work menu. It disap-
pears promptly.

Help Menu
See page 653.
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